Shuttle TT

for Casablanca
User manual

MACROISSYSTEM



Legal Information

We recommend that you carefully read the information in this manual, in order to avoid operator errors.

We have taken great care in developing and testing this program.

Since it is currently not possible to guarantee error-free operation under all circumstances and at all times, we can unfortunately not entirely exclude that some errors may have crept in.
Hence, MacroSystem Digital Video GmbH and its distributors do not guarantee a problem-free or completely error-free operation of the product.

As far as reasonably possible, we will rework the program in order to correct any errors and, if applicable, provide the new software for free to the users concerned.

Our liability for defects in material and/or workmanship for newly manufactured products is limited to 24 months. This is not the case when the law prescribes longer terms or in case of
damage to life, body or health, in case of deliberate or gross negligence of duty by the supplier or intentional concealment of a flaw.

The purchaser shall notify defects to the supplier without undue delay and in writing. Claims for reimbursement of expenses in connection with searching for defects will only be
accepted after prior agreement with the management of MacroSystem Digital Video GmbH.

Further claims by the purchaser on account of supplementary performance, including costs of transport, travel, labor and material are excluded. This is not applicable to claims for other
reasons such as newly discovered software errors.

Claims on the grounds of defects are excluded for minor deviations from the agreed quality, minor impairments in usability, normal wear and tear, or damage arising after the transfer of
risk from faulty or negligent handling, excessive strain, unsuitable equipment, or from other particular external influences not assumed under the agreement. Claims based on defects
attributable to improper modifications or repair work carried out by the purchaser or third parties and the consequences thereof shall be likewise excluded.

We cannot accept any liability for loss of data/time or any consequential damages that may occur as a result, particularly since we have no influence over correct software installation
and operation by the customer. MacroSystem Digital Video GmbH and its dealers therefore cannot be held liable for any defects or unintentional damage in connection with the
installation or use of the MacroSystem Shuttle TT.

Claims for damages and compensation, regardless of the legal basis, in particular due to breach of duties in connection with obligation or tortuous acts are therefore excluded. This shall
not apply in the case of mandatory liability, e.g. under the German Product Liability Act (Produkthaftungsgesetz), in the case of intent, gross negligence, injury of life, body or health, or
breach of essential contractual obligations. Damage compensation entitlement for breach of essential contractual obligations is, however, limited to the foreseeable damage typical of the
contract, unless there is willful intent or gross negligence or in case of injury to life, body or health. The provisions above do not imply a change of the burden of proof to the detriment of
the purchaser.

Neither MacroSystem Digital Video GmbH nor its dealers are responsible for any damages resulting either directly or indirectly through the use of the software or the operating
instructions. This applies in particular to loss of profits and compensation for expenses.
Any implied guarantee is excluded, including guarantee of suitability of the software or operating instructions for a particular purpose.

For this reason, you should make a backup of your video footage before you start using the device. We recommend that you do not delete the video footage and that you create a
backup copy beforehand.
Since it is possible that changes were made to the software after the manual was prepared, the functions shown and described in this manual might differ from the software.
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1. General information
1.1 Welcome

Thank you very much for purchasing the Shuttle TT.

We are grateful for your confidence and we hope that this
product will live up to your expectations.

The Shuttle TT will give you the opportunity to use your Casa-
blanca video editing system even more intensively than before.
Feel free to contact us for further questions or if you would like
to give us suggestions for improving the product.

Whenever you contact us, please have your customer number
or the serial number of your device at hand so that we can help
you more quickly.

MacroSystem Digital Video GmbH
IndustriestraBe 11, 96317 Kronach, Germany
E-mail: info@macrosystem.de

Fax: +49 (0) 9261-992049

Up-to-date information on MacroSystem products can be
found on the Internet: www.macrosystem.de

If you have specific technical queries, please contact our
technical support. Please do not forget to mention the serial
number of your device or your customer number each time you
contact us, if you know them.

Support Hotline, Germany

Phone: +49 (0) 9261-997080

Monday through Thursday between 10:00 am and 5:00 pm
Friday between 10:00 am and 4:00 pm

You can also visit our support forum on the Internet:
www.macrosystem.de/forum. In the forum, you will be able
to find assistance, step-by-step directions, and tips and tricks
for MacroSystem hardware and software products.

1.2 What is Shuttle TT?

The Shuttle TT is an input and control device used mainly for
trimming and splitting and that will make this work both easier
and faster.

It cannot replace the trackball in all menus, but it does provide
a meaningful addition in many menus.

The Shuttle TT has 15 different buttons for navigating in differ-
ent menus and also a so-called jog-wheel. This function con-
sists of an external rocker (jog) with which you can fast forward
and rewind (e.g. when splitting or trimming) and an internal
wheel with which you can go frame by frame.
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2. Installation

In contrast with other add-on products, the Shuttle-TT soft-
ware must not be installed. It has been factory pre-installed on
all devices with the corresponding Bogart version and you only
need to acquire the license code to activate it.

After activating the product, you can simply connect the
Shuttle TT via a USB port and work with it. It is not important
which USB port you use to do this, since all ports have the
same functionality. Please refer to the hardware manual for
your device to find out where the USB ports are.

The top nine buttons of the shuttle have removable button
covers. This makes it possible to simply label them with the
supplied preprinted template. It is up to you whether you de-
cide to put the letters under the button covers or — depending
on the button configuration (please refer to the next chapter)
— if you use the symbols in accordance with the configuration
table.

Assignments 1 and 2, with the corresponding symbol assignments
for the buttons of the Shuttle TT



3. Operation
3.1 Functions of the individual buttons

For the buttons A-l, the shuttle TT offers two configuration
possibilities from which you can choose. You will find the func-
tions of the individual buttons in the different configurations
modes in the chapter Configuration of buttons in individual
menus. A button has not been assigned a function if a menu
is not listed. The assignment can be change by pressing the Z
button (not possible in all menus).

The L and R buttons have similar functions as both big track-
ball buttons, but they don‘t replace them. Use L to confirm a
choice or an action, such as marking a scene in the scene bin,
and use R to abort or reject. Directly controlling the elements
under the mouse pointer is not possible, however.

The W button opens the navigation menu, in which you may
use the wheel of the Shuttle TT to select the menu you want to
access. This choice can be confirmed with L, rejected with R.

Depending on the menu, the X button is used to abort an ac-
tion. The table below contains an overview of the correspond-
ing action in each menu:

Splitting, trimming Switching between the different display
modes.

Insert, duration,
Period of time (audio
dubbing)

Video

The context menu is opened to make it
possible to select between “Moving” and
“Trimming”.

Opens a context menu for selecting an
input.

Transition, image pro-
cessing and title effects

The context menu is opened to make
it possible to select between different

products.
Individual image (video Opens a context menu to select the
effects) display.
Audio dubbing Opens a context menu to select the

sound track for correcting the sound
volume.

Inserting (audio dubbing) | Opens the context menu for sorting the

list.

The Y button is used to switch between using the storyboard
and the scene bin in the Edit menu, identified by a % symbol
for the title text of the part that is active at the time. This button
is also used to switch between the storyboard and the ef-

fect list in the transition, image processing and title effects. In
Video, Splitting, Trimming and Inserting, the Y button can be
used to change the position of the tool bar, just as in Duration
in the “Audio dubbing” menu and “Individual image” in Video
effects. In the “Audio dubbing” menu, pressing this button will
switch between the storyboard and the timeline display, if the
Gold Edition has been installed on your device.

The Z button includes the configuration options of buttons A-l,
which you can select.

When using wheel and jog, the so-called jog-wheel, you

will be able to control these also with both components, in

all menus where the storyboard is displayed. If you turn the
external jog, you will roll through the storyboard, just as you
would with the slider located below the storyboard. Other than
the wheel, the jog has a resting position and can be turned

in both directions until it reaches a clear stop. The farther you
turn, the faster the scroll movement is in that direction. Use the
inner wheel if you want to navigate scene by scene through
the storyboard, it will behave in a similar way as the individual
buttons located below the storyboard.

In the Edit menu there is also the possibility to navigate
through the scene bin with the wheel or the jog. The inner
wheel is used, just as with the storyboard, to scroll image by
image through the scene bin. The jog behaves like the slider. If
you are in one of the “Video effect” menus, both components
will allow you to navigate through the active effect list. The
wheel will allow you to scroll slowly, whereas the jog will allow
you to scroll faster through the effect list.

As described before, the Y button can be used to select what
has to be controlled by the wheel or the jog.

Sliders and individual context menus can also be used through
the wheel or the jog. The selection can accordingly be con-
firmed with L or rejected with R. Selecting a piece of music to
insert in audio dubbing is also possible.

Additionally, the wheel or the jog can also be used in the au-
dio dubbing menu to scroll through the individual sound clips
of the active sound track.

3.2 Key assignments in individual menus

Below, you will find a list of the functions that can be con-
trolled by buttons A-l, depending on the assignments. Some
function could not present, depending on whether you are
using the Basic, Silver or Gold Edition.

The lists indicate the situation at the moment of writing. It is
possible that the functions and available assignments will be
expanded.

Labelling the buttons with the supplied prints will help you to
become familiar with the operation of the shuttle as fast as
possible. Besides letters, we also offer you symbols to make it
easier to assign the functions:
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Function But- | Symbols 3.2.3 Edit
ton
. But- | Assignment 1 Assignment 2
Play, pause, preview A » > > ton
IN, start, position, index, B © n At st A p Play selected sceneor | © Inserting selected scene in
splitting, length, up, left storyboard, pause when storyboard
OUT, end, trimming, down, | C © out o pressed again
right B © Activate splittingmenu | @ Delete selected scene
Rename D AA | Name from storyboard
Insert, duration (audio) E ) nsert C @ Activate timming menu | @ Fetch back scene deleted
- - from storyboard or scene
Inserting scene in story- F (+] Add bin
board
D ~A  Rename selected scene -
Remove, erase G () strgx Entt cut
E © Activate insert menu 0O Activate insert menu
Insert H (] strgv Einfg Paste
- F © Insert selected scenein | p  Play selected scene or
Sound, scrubbing on/off, I Je! Audio Stumm Mute storyboard storyboard, pause when
sound volume pressed again
G © Delete selected scene © Activate splitting menu
from storyboard
3.2.1 Main menu H © Fetch back scene de- © Activate trimming menu
But- | Assignment 1 Assignment 2 leted from storyboard or
ton scene bin
A - Activate audio dubbing | - AA  Rename selected scene
B Activate video Activate transition effects
C Activate recording Activate image processing
offects 3.2.4 Splitting (Edit)
D Activate editing Activate title effects But- | Assignment 1 Assignment 2
E Activate recording, editing Activate recording, editing ton
F Activate audio dubbing - A » Play -
G Activate transition effects Activate video B © Select split position © Discard
H Activate image processing Activate recording C - © Use
effects
D AA  Rename scene J2 Sound on/off
Activate title effects Activate editing
E - -
F - » Play
3.2.2 Video settings G © Discard ®© Select split position
But- | Assignment 1 Assignment 2 H © Use -
ton I J2 Sound on/off AA  Rename scene
A Brightness selection SVHS input selection
B Contrast selection DV input selection 3.2.5 Trimming (Edit)
C Color selection - But- | Assignment 1 Assignment 2
D - ton
E Back cinch input selection Back cinch input selection A > Play -
F SVHS input selection Brightness selection B i IN/select start -
G DV input selection Contrast selection c out OUT/select end -
H - Color selection D AA  Rename scene J2 Sound on/off
| - - E - -
F - p Play
G - in  IN/select start
H - ot OUT/select end
I J2 Sound on/off AA  Rename scene
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3.2.6 Insert, period of time (Edit)

3.2.9 Trimming (audio)

But- | Assignment 1 Assignment 2 But- | Assignment 1 Assignment 2
ton ton
A » Play - A » Play -
B in  IN/select start - B in  IN/select start -
C out OUT/select end - C out OUT/select end -
D »u» Play background and J2 Sound on/off D AA  Rename -

insert side-by-side E _ _
E - - E - » Play
F - Pl

> i G - in  IN/select start
G - n_IN/select start H - ot OUT/select end
H - out OUT/select end | i A Rename
| J2 Sound on/off »u» Play background and
insert side-by-side

3.2.7 Recording, edit (audio)

But- | Assignment 1 Assignment 2
ton
A »n Play, pause during play -
B © Activate splitting menu © Delete
C @ Activate trimming menu | @ Fetch back deleted
sample
D AA  Rename J2 Select slider for level
control
E - -
F - »u1 Play, pause during play
G © Delete © Activate splitting menu
H © Fetch back deleted @ Activate trimming menu
sample
J2 Select slider for level AA  Rename
control

3.2.8 Splitting (audio)

But- ‘ Assignment 1 ‘ Assignment 2
ton

A p Play -

B ® Select split position © Discard

C - © Use

D AA  Rename -

E - -

F - p Play

G © Discard ®© Select split position
H © Use -

| Abort the splitting menu | AA Rename

3.2.10 Audio dubbing

But- | Assignment 1 Assignment 2
ton
A »n Play selected scene in © Insert a sound sample
storyboard, pause when
pressed again
B ® Move the individual © Remove the selected
sound track up sound sample from the
sound track
C @ Move the individual -
sound track down
D AA  Select volume control for | 2 Select volume control
correction
E © Select duration menu © Select duration menu
F © Insert a sound sample »u Play selected scene in
storyboard, pause when
pressed again
G © Remove the selected Change to the original
sound sample from the sound track
sound track
H - © Move the individual
sound track down
| J2 Select volume control AA  Select volume control for
correction

3.2.11 Inserting (audio dubbing)

But- | Assignment 1 Assignment 2
ton
A p Play the selected sound -
sample
B - -
C - -
D - -
E - -
F - » Play the selected sound
sample
G - -
| - -




3.2.12 Period of time (audio dubbing)

But- | Assignment 1 Assignment 2

ton

A p Play -

B in  IN/select start -

C ot OUT/select end -

D - J2 Sound on/off

E - -

F - » Play

G - in  IN/select start
H - out OUT/select end

J2 Sound on/off

3.2.13 Envelope (audio dubbing)
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3.2.15 Specify effect duration (transition effects)

But- | Assignment 1 Assignment 2

ton

A - -

B Select duration 1 -

C Select duration 2 -

D Select duration 3 -

E - -

F R -

G - Select duration 1
H - Select duration 2
I - Select duration 3

3.2.16 Single image (transition and image processing

But- ‘ Assignment 1 Assignment 2 effects)
ton But- | Assignment 1 Assignment 2
A p Play sample © Insert ton
B © Jump one editing point | @ Remove A Display preview Display “Effect”
to the left B - Display “Original + Ef-
C @ Jump one editing point - fect”
to the right C - -
D Play all sound tracks 13 Select volume slider D - -
E - - E Display “Original” Display “Original”
F © Insert » Play sample F Display “Effect” Display preview
G © Remove © Jump one editing point G Display “Original + Ef- -
to the left fect”
H - © Jump one editing point H - -
to the right I _ -

J2 Select volume slider

Play all sound tracks

3.2.14 Transition effects

Here, it is possible to select a position in the scene without
activating the relevant slider via the wheel and the jog of the
Shuttle TT.

3.2.17 Image processing effects

But- | Assignment 1 Assignment 2

But- | Assignment 1 Assignment 2

ton

A p Play © Insert effect

B Open “Specify effect © Remove effect
duration”

C Individual image Calculate effect

D Display preview -

E Display extended Display extended
preview preview

F © Insert effect » Play

G © Remove effect Open “Specify effect

duration”
H Calculate effect Individual image

Display preview

ton

A » Play © Insert effect

B Open “Specify duration” | @ Remove effect

C Individual image Calculate effect

D Display preview -

E Display extended Display extended
preview preview

F © Insert effect » Play

G © Remove effect Open “Specify duration”

H Calculate effect Individual image

| - Display preview
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3.2.18 Specifying duration (image processing effects)

But- | Assignment 1 Assignment 2

ton

A - -

B Select “1s at the start” -

C Select “1s at the end” -

D Select “Entire scene” -

E Select “Duration” Select “Duration”

F R -

G - Select “1s at the start”
H - Select “1s at the end”
| - Select “Entire scene”

3.2.19 Duration menu (in “Specify duration” of the
image processing effects):

But- | Assignment 1 Assignment 2
ton

A - -

B in | IN/select start -

C out | OUT/select end -

D - J2 | Sound on/off
E - -

F _ -

G - in | IN/select start
H - out | OUT/select end
I J2 | Sound on/off -

3.2.20 Shuttle TT with QuadCam

Shuttle TT also supports working in the (optionally available)
QuadCam software product.

The L and R buttons support here, just as in other menus, the
confirmation or cancellation of an action.

The assignment of buttons A-l in QuadCam is as follows:

But- | Assignment 1 Assignment 2
ton

A » Play Select insert 1
B - Select insert 2
C - Select insert 3
D - -

E Select background Select background
F Select insert 1 p Play

G Select insert 2 -

H Select insert 3 -

| - -
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